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Preface

Photogrammetry utilizes measurements obtained from aerial photography and stereo plotters to
generate digital map data that contains man-made and natural terrain features which are referenced
to the State Plane Coordinate System of Georgia. This data is then submitted to Survey Data
Engineers as planimetric MicroStation (.DGN) files and topographic 3D mapping Digital Terrain
Model (.DTM) files in InRoads. The digital mapping data is used as a database in the development
of highway project plans.

These Photogrammetry Guidelines have been developed as part of the statewide GDOT
implementation of MicroStation V8i and InRoads V8i. The intent of this document is to provide
guidelines and standards for processing photogrammetric data in InRoads V8i. These guidelines
must be followed in detail in order to conform to the current GDOT standards for producing the
required photogrammetric deliverables. Updates to this document will be made periodically when
minor revisions, additional information, and/or enhancements are added.

If there is any approved deviation from the standard file and data naming/feature style conventions
as prescribed by this document - a detailed description of the deviation(s) and approved reasons for
the deviation(s) shall be documented and included with the project files in electronic format.




Contact Information

To submit any comments or questions regarding the information contained in this document,
please contact the Engineering Software Standards and Support by email at the following
address:

SolutionsCenter@dot.ga.gov

In the Email Subject Header, please reference the InRoads Photogrammetry Guidelines
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Overview

These Guidelines cover the GDOT standards for processing Photogrammetric (Mapping) Survey
Data by utilizing the MicroStation V8i and InRoads V8i software(s). These procedures depict the
Project Initialization Standards and Conventions to create an InRoads Mapping Project to GDOT
format and the processes to create/generate the files which are to be submitted as deliverables to
the Survey Data Engineer.

For detailed Photogrammetric processing instructions, please refer to the Training Manual:
Introduction to InRoads for Photogrammetry Training Guide

Document Content
Below is a list of topics covered in this document:

e Project Initialization Standards

e Standard Conventions

e Photogrammetry Project Deliverables

e Converting Projects from CAICE to InRoads
e Appendix A

Xi
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1. Project Initialization Standards

Project Initialization Standards have been established in order to promote consistency and assist in
the organization of project data. These standard project schemes help to ensure uniformity for all
users who may work on the project.

This section covers the following topics:

GDOT Standard Files (MicroStation and InRoads)
Standard Project Structure

Starting MicroStation V8i and InRoads V8i
Overview of InRoads Interface

InRoads Project Defaults

Survey Default Preferences

InRoads “Locks”

Application and Variable Manager Add-Ins
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1.1 GDOT Standard Files —MicroStation and InRoads

In order to conform to current policy for plan deliverables — GDOT provides the requisite files
needed to standardize InRoads and MicroStation to GDOT requirements. The first step in the
development of an InRoads and MicroStation Project is to ensure that these standard files are
being utilized. Instructions for downloading/installing the executables are included on the
GDOT R.O.A.D.S. web page (see the links depicted below). These files are required for any
Photogrammetry Projects generated for GDOT.

e MicroStation Standard Files Location For Internal GDOT Users — a server location has
been established to map a drive (an N:\ Drive) in order to access the latest MicroStation
Files. Once the internal user maps the N:\ drive — all of the standard MicroStation Files will
be available through this mapped drive.

o MicroStation Standard Files Location For External Users - a MicroStation V8i
(CaddALLVS8i.exe) executable file is available and located in a download
executable which can be accessed from the GDOT R.O.A.D.S. web page. This executable
contains all of the GDOT MicroStation V8i standard files. This file can be downloaded by
navigating to the MicroStation and InRoads links from the following location:

http://www.dot.ga.gov/doingbusiness/PoliciesManuals/roads/software/Pages/default.aspx

¢ InRoads Standard Files Location For Internal and External Users - an InRoadsALL
executable file (InRoadsALLV8i.exe) is available and located in a download
executable which can be accessed from the GDOT R.O.A.D.S. web page. This executable
contains all of the GDOT InRoads V8i standard files. This file can be downloaded by
navigating to the MicroStation and InRoads links from the following location:

http://www.dot.ga.gov/doingbusiness/PoliciesManuals/roads/software/Pages/default.aspx
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The InRoadsALLV8i.exe file contains all of the standard GDOT files which are required to
generate projects to GDOT standards. The user will perform the following steps to extract
and set-up the GDOT Standard InRoads Files:

1.

2.

Close MicroStation V8i and InRoads V8i if they are still open.

Navigate to the InRoads links from the following web page:
http://www.dot.ga.gov/doingbusiness/PoliciesManuals/roads/software/Pages/default.aspx

Save the InRoadsALLVS8i.exe file to the hard drive and then double click the file.

The self-extractor will download the GDOT InRoads Standard Files to the
following locations:

a. C:\InRoads Data\Standards\
GDOT _Standard V8i.xin
GDOT _Standard V8i.itl
Project_Data_Sheet_MultipleAlign.docm
Photogrammetry_InRoads QA.docx
Survey Data Processing_InRoads QA.docx
Design Data_ InRoads QA.docx

b. C:\InRoads Data\Component Documentation
= GDOT Component Description Help Documentation

c. C:\InRoads Data\Style Sheet Documentation
= GDOT Style Sheet Help Documentation

d. C:\Program Files\Bentley\InRoads Group V8.11\XML Data\GDOT\
= GDOT Style Sheets

For detailed instructions on downloading and installing InRoadsALLV8i.exe -
navigate to the InRoads links from the GDOT R.O.A.D.S. web page and click on
the Downloading and Running InRoadsALLV8i.pdf document for installing these
standard files.
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1.2 Standard Project Structure

The standard File Structure for InRoads is a Project Folder (which is named for the PI # of the
Project — Example: 123456) located as a sub-folder under C:\InRoads Data — Example:
C:\InRoads Data\123456. The Project Files are then located in a Photogrammetry sub-folder
under the PI # — Example: C:\InRoads Data\123456\Photogrammetry -- This Project Folder
contains the individual InRoads Data Files. (See Table 1.1)

Table 1.1
InRoads Project Structure

InRoads Project Structure | C:\InRoads Data\PI Number\ Photogrammetry

InRoads Project Structure | C:\InRoads Data\123456\ Photogrammetry
(Example)

Some examples of InRoads Data File Types are:

1.DTM ------ (Digital Terrain Model File) — contains Surface data

2. .FWD ------ (Survey File) — contains Field Survey data

3. .ALG------- (Geometry File) — contains Geometric Point, Horizontal and Vertical data
4. .IRD ------- (Roadway Design File) — contains the Design Surface data

5. .RWK------ (Project File) — contains project data for InRoads files in ASCII format

6. ITL-------- (InRoads Template File) — contains InRoads Templates for cross-sections
7. .SDB------- (Drainage File) — contains the InRoads Storm and Sanitary data

Although InRoads consists of the above file types -- the “Photogrammetry Data” will usually
consist of the following file types and will be located in the C:\InRoads Data\PI Number\
Photogrammetry folder:

e Processed DTM Surface file (P1#_ Map.dtm)
e Processed topographical DGN file (P1#_Map.dgn)
e Processed DGN PDF Plot Files (P1#_Mapl.pdf, PI# Map?2.pdf, etc)

It is highly recommended to backup the Project Folder (which contains these individual data
files) after each work session to your Group Account on the GDOT Server if you are a
GDOT Employee (or to an appropriate Business Server if you are a GDOT Consultant).
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1.3 Starting MicroStation V8i and InRoads V8i

The user will be working in both MicroStation V8i (the CADD Software) and InRoads Suite
V8i (the Survey/Design Software). The MicroStation CADD Software is used for the viewing
and manipulation of graphics derived from InRoads. The InRoads Software is the database in
which the Photogrammetry and Surveying data is created and processed. The user will select
the standard GDOT 3D *seed” file to use as the “seed” DGN in order to create the three
dimensional “Working” DGN file. This “Working” DGN file is used to display the temporary
and/or permanent graphics in InRoads.

This section details the following processes:

e Steps to Create a Photogrammetry “Working” DGN File
e Steps to Open an existing Photogrammetry “Working” DGN File

The “Working” DGN file will be saved to the following folder location:
C:\InRoads Data\PI Number\ Photogrammetry\Standards

(IF the Standards folder — does not yet exist — the user will need to create the folder).

Table 1.2
Standard Naming Convention of the “Working” DGN File

Working DGN File Name C:\InRoads Data\PI Number\
Photogrammetry\Standards

GDOT 3D Working File.dgn

The MicroStation software will open first before InRoads. After the MicroStation Splash
Screen appears, the MicroStation Manager dialog (See Figure 1-1) will open so that a
“Working” DGN file can be created or an existing “Working” DGN file can be opened. The
InRoads software can then be initiated.
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1.3.1 Stepsto Create a Photogrammetry “Working” DGN File
The Photogrammetry “Working” DGN file will be created from the GDOT_V8 3D.dgn
seed file. Following are the steps to create a Photogrammetry “Working” DGN File:

1. From the desktop, double-click on the GDOT MicroStation V8i Edition icon.

Double click on the
icon labeled
GDOT MicroStation
V8i Edition.

2. After the MicroStation Splash Screen appears, the MicroStation Manager dialog
box will open. (See Figure 1-1).

New File Icon

File Open - C:AInRoads Data\123456\P hotogrammetry\Standards

Laok in: | |2 Standards w o ¥ - :1
-1 Size  Type Date Mo
% } File Folder 3/19/200
My Fecent
Dacurmetts
Desklop
My Documents
F-
< P >
hy CompLiter
File name: GDOT 30 Working File.dgn v User: | GDOT_User v
‘l'] Files of wpe: CaD Files [*.don;”.dwa;”. dxf] w Project: | untitled v
My N;t:v)ork [ Open as read-only Interface: | default v

Figure 1-1 Starting MicroStation V8i and InRoads V8i

3. Inthe MicroStation Manager dialog box, click on the New File icon g (See
Figure 1-1) depicted above. The New File command will be used to create the
“Working” DGN file.

4. After the New File g command is selected, the MicroStation New File dialog
box will open. (See Figure 1-2).
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e Click in the Save in: Pulldown - and browse to the C:\InRoads Data\P| Number\
Photogrammetry\Standards location to save the new “Working” DGN file

e Inthe File name: Pulldown — enter GDOT 3D Working File.dgn

e Inthe Save as type: Pulldown — select MicroStation DGN Files (*.dgn)

e Inthe Seed: Field - ensure the seed file name is GDOT_V8 3D.dgn

The Seed File should already be entered in the field based on the current MicroStation
configuration.

The inputs should now correspond to the screen capture depicted in Figure 1-2 (as
shown below).

New - C:\InRoads Data\123456\Photogrammetry\Standards @@
Savein | I3 Standards “ O =
N (=) Original Backup
Iy Recent
Docurnents
'7\-_‘..
Desklop

My Documents

L
tdy Computer
ﬂ,‘] File pame: GDOT 3D Working Flle. dgn v
hy N;E-n-:ork Save az type: MicraStation DGM Files [*.dan) L
Seed: MAGDOT_4M\Corparate_Workspace'MicroStation\Seed\GDOT_V8_30.dgn
Figure 1-2 MicroStation New File Window
5. Click the Save command button and the MicroStation Manager dialog box will
appear.
6. Inthe MicroStation Manager dialog box — highlight the file just created (GDOT 3D
Working File.dgn) and click the Open button.
7. The MicroStation V8i interface will then finish opening.
8_ InRoads | GDOT Tools

In the Main MicroStation Pull-down Menu — click on the InRoads pull-down: st |
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9. Then select InRoads Suite — and the InRoads V8i interface will open. Once
InRoads and MicroStation are up and running, the desktop should look similar to that
of Figure 1-3 and Figure 1-4.

I} c:\inRoads Datal1 23456\Photogrammetry\Standards\GDOT 3D Working Flile.dgn [3D - V8 DGN] - MicroStation VBi

Fle Edit Element Settings Took Ublities Warkspace Window Help Descartes InRoads GDOT Toals
Survey Feet | |Inches v Full Size 1=1 v @ = }l[none' "
5 Ty o W . my 2 §
B-0-B-23-2-0u@: 00 e b B v o
TE & View 1 - Top, Default
B-@- AR Qe A N vEREFyBaD=mEd g6

PR BT

| T | Bl 2] 2] 2] s8] 7]l x Y z

Display complete “working Units conform to GDOT standards, od | & |Default

Figure 1-3 Main MicroStation V8i Window

T Bentley InRoads Suite V8i

File  Surface Geometry Bridge Drainage Survey Ewaluation Modeler Drafting Tool: Help

Surface Mame Description File: Marmne By Wwhom Last Revised Acces

- £ Surfaces EDeFauIt heross 2/11/2009 11:3... Read-

+ £ Default

£8 sSurfaces = Geometry | [F 4 <

Ready

Figure 1-4 Main InRoads V8i Window
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1.3.2 Steps to open an existing Photogrammetry “Working” DGN File
If the Photogrammetry “Working” DGN file has been created previously — use the following
steps to open a Photogrammetry “Working” DGN File:

1. From the desktop, double-click on the GDOT MicroStation V8i Edition icon.

Double click on the icon
labeled

GDOT MicroStation

V8i Edition.

2. After the MicroStation Splash Screen appears, the MicroStation Manager dialog
box will open. (See Figure 1-5).

File Open - C:\InRoads Datal123456\Photogrammetry\Standardsl @@
Look jr: | (£ Standards v 3 ¥ = M- TJ F_.ﬁ a0 - Y8 DGH
LY Mame Size Type Date Mo
bﬁ |2y original Backup File: Folder 3197200
My Recent EDOT 30 Warking Flile.dgn G63KE Eentley MicroStakio,..  7f16f200
Documents
7_.%%
Desktop

ty Documents

-
. JIE 5
tdy Camputer
File name: GDOT 20 Warking Flile. dgn v User: | GDOT_User v
‘-_-‘] Files of type: CaD Files [7.dgn;”. dwg;” d=f] w Broject: | untitled w
hdy N;t‘u:ork [] Open as read-only Interface: | default w

Figure 1-5 Starting MicroStation V8i and InRoads V8i

3. Inthe MicroStation Manager dialog box, browse to the C:\InRoads Data\PI
Number\ Photogrammetry\Standards location and highlight the (GDOT 3D Working
File.dgn) and click the Open button.

4. The MicroStation V8i interface will then finish opening. Then select
InRoads>>InRoads Suite from the Main MicroStation Pull-down Menu. Once
InRoads and MicroStation are up and running, the desktop should look similar to that
of the previous screen captures depicted in Figure 1-3 and Figure 1-4.
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1.4 Overview of InRoads Interface

As mentioned previously - the user will be working in both the InRoads Design Software and
the MicroStation CADD Software. The InRoads Software is the database in which the
Photogrammetry and Surveying data is created and processed.

Shown below is a diagram which depicts the InRoads Explorer objects and a brief overview of
the InRoads Explorer Interface:

Workspace Feedback

Bar Menu Bar Toolbars Pane

o Bentley InRoacls Suite XM Edition

Fil= Suface Geometry Bridge Qrainage Survep  Ewaluation Modeler Diafting Tool: Help

<Unnarned: vESE &% B s B 2Oy T B | &

A 3R A\E 2w B B B E LEAE T CEY /L NZIE.
EHe& o H\mFL S o AR 2 s

Surface Mame Descripkion File Mame B oo Lask Revised Access Mode P
EDeFault heross B/29)2007 11:0... Read-Write o]

S Jsurfaces
+- £ Default

£8 surfaces = Geometry | 5 4 » =
Toggles the Feature Highlight Lock. r

Status Bar Scroll Bar

Workspace Bar — Contains all of the InRoads Project Data information

Menu Bar — Contains the pull-down menus to access InRoads commands

Toolbars — Contains default and customized toolbars to access InRoads commands
Feedback Pane — Contains details of selected Project Data from the Workspace Bar
Scroll Bar — Enables the user to view more of the InRoads Explorer Interface. (The Scroll
Bar may not be visible if the InRoads Interface is already viewed to extents).

e Status Bar — Contains InRoads messages and prompts (Please note: InRoads may direct
you to locate something graphically in MicroStation -- some of these prompts may display
in the MicroStation Status Bar instead). It is very important that the user review both the
InRoads and the MicroStation Status Bar for prompts and information.
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1.5 InRoads Project Defaults

The InRoads Project Defaults setting allows you to define the “default folder locations” for
projects. A Project Default configuration can then be saved for each project so that multiple
projects can be accessed. This configuration allows you to easily navigate between projects.
Once the Project Folder locations are saved in the Configuration, the projects can then be
accessed by selecting the appropriate Project Configuration Name. The Project Defaults also
contain the location for selecting the standard GDOT InRoads Preference File
(GDOT _Standard V8i.xin).

The standard Project Default configuration for Photogrammetry projects will be P1#_Mapping.
Each Photogrammetry Project Default will consist of this naming structure in order to easily
navigate between projects. (See Table 1.3)

**Once the Project Default Location is set for a particular project — this will also be the default
folder location whenever the InRoads commands of File » Save and File ™ Close are used.

Table 1.3

Project Defaults Configuration

Project Default Structure | PI Number_Mapping

Project Default Structure | 123456_Mapping
(Example)

Following are the steps to create a Photogrammetry Project Default Configuration
(Substitute the appropriate Pl # as required):

1. Click File»Project Defaults from the InRoads pull-down menu to access the Set
Project Defaults dialog box.

2. Click New and enter 123456_Mapping in the New Configuration dialog box. Then
click OK.

3. Under the Default Preferences section - Click in the Preferences (*.xin): field and
then click the Browse button to navigate to the following file:
C:\\InRoads Data\123456\Photogrammetry\Standards\GDOT _Standard V8i.xin
file and click Open.

4. Under the Default Directory Paths Section - Click in the Project Default Directory:
field and then click the Browse button to navigate to the folder:
C:\InRoads Data\123456\Photogrammetry\. Next - click Open.

5. Under the Default Directory Paths Section — copy and paste the following text into
each entry field shown below: C:\InRoads Data\123456\Photogrammetry\
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Report Directory: - C:\InRoads Data\123456\Photogrammetry\
Projects (*.rwk): - C:\InRoads Data\123456\Photogrammetry\
Surfaces(*.dtm): - C:\InRoads Data\123456\Photogrammetry\
Geometry Projects: (*.alg): - C:\InRoads Data\123456\Photogrammetry\
Template Libraries:(*.itl): - C:\InRoads Data\123456\Photogrammetry\
Roadway Design: (*.ird): - C:\InRoads Data\123456\Photogrammetry\
Survey Data: (*.fwd): - C:\InRoads Data\123456\Photogrammetry\
Drainage: (*.sdb): - C:\InRoads Data\123456\Photogrammetry\

6. Under the Default Directory Paths Section - Click in the Style Sheet (*.xsl): field and
then click the Browse button to navigate to the folder:
C:\Program Files\Bentley\InRoads Group V8.11\XML Data\GDOT\. Next - click
Open.

The Project Defaults should look similar to the screen capture depicted in Figure 1-6 (as
shown below).

; Set Project Defaults @

Configuration Mame: 1 23456_Mapping v Apply

Diefault Preferences Cloze

Prefersnces [*xin]: CMnRoads D atah1 234564 Phatogrammetryt Standard:AGDOT_Sta Copy..
Turnouts [ kxt): Renarme...
Drainage Structures [* dat):

Rainfall Data [ idf):

[elete

Browse. ..
Bridge Sections [*.tat]:

Import....
Drafting Motes [ dft);

Export...
Fay Items [*. mdb]:

=
o
Iz

Help
Default Directony Paths

Project Default Directony: | C:\InRioads Datah123456%Photogrammetryt

Report Directory: MR oads Datahl 234565 Phatogrammetry,
Projects [*.nak]: CMInPoads D atah1 234564 Phatogrammetryt,
Surfaces [*.dtm): C:MnFoads Datayl 234565Phatogrammetry's
Geometry Projects [".alal | C\InRoads Datahl 23456 \Photagrammetry
Template Libraries (t): | C:lnRoads Datah] 23456\ Photogrammetry'
Roadway Design [*.ird): C:MnRoads Datak123456%Phatagrammetry',
Survey Data [ fwd): C:MnRoads Datahl 234565Phatogrammetrys
Drainage [ zdb]: C:AnRoads Datahl 23456\Photogrammetryh,
Style Sheet [xs) C\Program FilesEentieyhInFioads Group YE11'ML DatabGDOTY

Quantity Manager [*.mdb]:

Default Grid Factar Expart
Grid Factor: 1.0000 [ dsctivee: Qrily

Figure 1-6 Project Defaults

7. Click Apply and then click Close.
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1.6 Survey Default Preferences

The Survey Default Preferences must be loaded in InRoads in order to conform to standards for
the processing of Mapping Projects. This is a very important step to ensure that standards are
followed for any Photogrammetric data that will be processed. The Survey Default Preference

loads the Precision Settings, Tolerances, Units and Formats, etc. Once the Survey Default

Preference is loaded — the project will retain these settings each time the project is accessed.

Following are the steps to set the Survey Default Preferences:

1.

5.

Click Tools» Options from the InRoads pull-down menu to access the Options dialog

box.

In the Options dialog box - click on the General Tab and the General Tab dialog box

will appear.
; Options
Tolerances | Factorz || Abbreviations | Rail Sight Diztance
Precizion General Units and Faormat Geometrny

L“'\H‘.T‘h‘h‘\‘\ﬂ*

General Tab

In the General Tab dialog box select the pull-down next to Preferred Preference
Name:

Preferred Preference Mame: | o ) pywEy DEFALLT +

Select Survey Default — to load the Survey Default Preference Settings.

In the General Tab dialog box click the command button named Preferences...
(Located at the bottom of the dialog box) and the Preferences dialog box will open.

; Preferences

I Apply ] [ Preferences. .. ] [ Cloze ]

Hame:
Default

DesiEn Lrefault Load

Save

Close

v

Save b

Delete

IIIIII@

Help

Active Preference: Survey Default

In the Preferences dialog box — select Survey Default. Then click Load and then
click Close.
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6. The Survey Default Preference should now correspond to the screen capture depicted
in Figure 1-7 (as shown below).

; Options
Talerances | Factors || Abbreviations | Fail Sight Diztance
Precizion General Units and Format GFeometmy
Ensure that the “Refresh Tsh Pa
. ges Hel

Command Settings on TabStle:  [5iacked Z
Preference Change” is
checked: 9 [ Always Activate First Page

Collapze Dialog Boxes Automatically

Editar: Matepad -

Default Cell: MARK w

Coordinate Seguence: Morthing/Easting |+

Preferred Preference Mame: | 5, a0 D efault w

Refresh Command Settingz on Preference Change
[] Oimit Automatic: Graphics Fefresh

[ Re-triangulate without Prompting

[] Test Size / Cell Scale Lock

N N R

[ Apply ] | Freferences. .. | [ Cloze ]

Figure 1-7 Survey Default Settings

7. Click Apply and then click Close.

The Survey Default Preference is now loaded. This Preference loads the appropriate data for
ALL of the tabs in the Options dialog box. The individual tabs (Tolerances, Geometry, Units
and Format, etc.) will automatically be configured for use in Mapping and Photogrammetry.
These individual tab options will NOT need to change. Once the Survey Default Preference is
loaded — the project will retain these settings each time the project is accessed.

1.7 InRoads “Locks”
InRoads contains several “Locks” which are used by many InRoads commands to control
different aspects of the selection and viewing of data as well as the reporting of data. There are
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basically two types of “Locks” — On/Off “Locks” and Switch “Locks”. (Switch “Locks” contain
different modes but one mode is always active and the user can switch between modes). Both
types of “Locks” can be changed by the user as the situation dictates during the course of the
database generation. These locks affect many commands — so it is very important that the user
understand the use of these locks. If an InRoads command does not function as expected when
utilizing the Surface Viewing or Reporting commands -- a “Lock” may have been inadvertently
turned on/off.

The following section contains a brief overview of some of the InRoads “Locks”. Only the
“Locks” pertaining to the Photogrammetry aspect will be reviewed. As mentioned previously
the “Locks” may be changed as situations dictate — but the settings depicted in the following
section are applicable for most Photogrammetry Projects. 1t is a very important step to ensure
that the *“Locks” are set accordingly. (See Table 1.4)

Following are the steps to access the InRoads “Locks”:

Click Tools»Locks from the InRoads pull-down menu. Each time a “Lock” is changed — the
pull-down menu will close and the user must click on Tools»Locks again to access the Locks

pull-down.

Table 1.4
InRoads Locks Settings
Feature Filter Unchecked
Feature Highlight Unchecked
Style Unchecked
Pencil/Pen * Set to Pencil
Delete Ink Unchecked
Locate =# Set to Features
Point Snap |v Checked
Element Snap Unchecked
Station Unchecked
Cogo Audit Trail Unchecked
Report ¥ Checked
Toolbar |+ Checked

Following is a brief overview of the InRoads “Locks”:

(See Table 1.5)
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Table 1.5
InRoads Locks Overview

Feature Filter
displays or obscures Surface Features based on a filter (also controls Survey Style Filter)

Feature Highlight
highlights the feature in plan view when selected from a list

Style
determines if a dialog box is displayed for a surface command or cross sections

Pencil/Pen
controls the redisplaying of Graphics

Delete Ink
allows redisplayed graphics to replace graphics in pen mode

Locate
controls if Locate Buttons snap to Graphics or Features

Point Snap
controls the ability to snap to points in Geometry Project

Element Snap
controls the ability to snap to elements in Geometry Project

Station
controls the Stationing as it pertains to Cross Sections

Cogo Audit Trail
controls the reporting of coordinate geometry results to a text file

Report
controls if Report is displayed or not displayed in a dialog box

Toolbar
displays or turns off the Locks Toolbar
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1.8 Application and Variable Manager Add-Ins

InRoads contains several Application and Variable Manager “Add-Ins” which must be selected
and added to the InRoads Program in order to access the standard GDOT customized menu
applications/translators for Photogrammetry and Survey. Once the Application and Variable
Manager Add-Ins are selected — the settings are written to registry keys in the user’s profile.
This ensures that each time InRoads is accessed in the user profile -- these settings will already
be available. These add-ins will only need to be added once and will then be accessible in all of
the InRoads Modules and InRoads Projects.

The “Application and Variable Manager Add-Ins” must be set accordingly in order to access the
required GDOT Photogrammetry/Survey commands and translators.

This section details the following processes:

e Steps to select the Application Add-Ins
e Steps to select the Variable Manager Add-Ins

1.8.1 Steps to select the Application Add-Ins:

1. Click Tools»Application Add-Ins from the InRoads pull-down menu and the
following dialog box will appear:

] O

;Applicatiun Add-ins

i ctive Project Settingsz Add-n ~
Auztian Railway Data Exchange Add-n
Cant Editar Add-In § ;
Card/1 Translator Add-In ; J
CEAL Translatar Add-n

Compare Surface Add-n

Copy Preference Add-ln

D Translator Add-n

Design Checks ddddn b

N ety gy by A bty ey by by, A ey

2. Select the following Application Add-Ins by clicking an [X] by the appropriate Add-

In:

@ Active Project Settings Add-n E Lot Layout Add-In

E Copy Preference Add-In E kultiple Harizantal Element Begression Analysiz Add-n
E Dizplay Superelevation in Plan Add-In E Multiple Yertical Element Regression Analysiz Add-n
[ Glabal Scale Factors AddHn [Mamed Symbology Toolks Add-n

[<]Horizontal and Yertical Elements Add-n E Remove Uszer Data Add-In

E Hydralogy and Hyedraulics Add-n E Traverze Edit Add-In

(] Impart AMSA Add-n [ Wariable Manager Add-in

E Import SAY Add-In

3. Click OK to accept the settings and to close out of the dialog box.
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1.8.2 Steps to select the Variable Manager Add-Ins:

1. Click Tools»Variable Manager from the InRoads pull-down menu and the following
dialog box will appear:

- Variable Manager E]@@
Formatting: (i Applp

@ eneral - Farmat Bearing with Leading :

[ |General - Farmat Station E quation withe

Survey - Import SDR33 as Easting £ Nc
Eﬂotatiun / Dizplay:
|:| General - Retain Cell Levels
@ Geometry - Annotate Bearings with Spa
|:| Gearnetry - Omit First and Last Station £ .,

Descrption

T T S TR R

2. Select the following Variable Manager Add-Ins by clicking an [§] by the appropriate
Variable:

E General - Format Bearing with Leading Zero Option

E Geometry - Annotate Bearngs with Spaces

@ Geometry - Alphanurmeric Mames in Create/E dit Alignrment by Cogo Paints

3. Click Apply to accept the settings and then click Close to close out of the dialog box.
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1.9 Starting a Photogrammetry Project in InRoads

After creating the Photogrammetry Project folder of C:\InRoads Data\PlI
Number\Photogrammetry, setting the Project Default Settings and the Survey Default Settings
— the Photogrammetrist will then copy the Standards folder (which is downloaded through the
INRoadsALLV8i.exe executable) to the C:\InRoads Data\Pl Number\Photogrammetry
folder.

1.9.1 Copy the “Standards” folder which is downloaded from InRoadsALLV8i.exe

Important Step:

After installing InRoadsALLV8i.exe — the user will copy the Standards folder under
C:\InRoads Data\ to the Project Location. The rest of the Standard Files will remain in
the default install location.

Whenever a new Project is created — the Photogrammetrist will download and install
InRoadsALLV8i.exe. The files will be extracted to the Default Location(s). The
Photogrammetrist will then perform the following step:

e The user will copy the C:\InRoads Data\Standards Folder to the InRoads Data\PI# \
Photogrammetry folder. (Example: C:\InRoads
Data\123456\Photogrammetry\Standards).

Table 1.6
Copy Standards Folder to Project Folder

C:\InRoads Data\Standards Copy To »» C:\InRoads Data\Pl #\Photogrammetry
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2. Standard Conventions

This section provides an overview of the GDOT standard Project, File and Object naming
conventions. The standard Feature Types for DTM (Digital Terrain Model) data are discussed and
the GDOT Preference File (.XIN) is reviewed. Feature Code Tables are also listed which provide
the standard Feature Codes/Feature Styles to utilize for Photogrammetric and/or Field Survey
Projects.

This section covers the following topics:

Project and File Naming Conventions

Standard Surface Feature Object Names

Standard Surface Feature Types

Standard Preference File (XIN)

GDOT Standard InRoads Photogrammetry Feature Codes

GDOT Standard InRoads Field Survey Feature Codes

GDOT Photogrammetry Code Conversion Table -- CAICE to InRoads
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2.1 Project and File Naming Conventions
As mentioned previously in Section One - in order to ensure project and file naming
consistency — standard Project and File Naming conventions have been established.

This section details the following Standard Naming Conventions:

e Standard Project Naming Conventions
e Standard File Naming Conventions

2.1.1 Standard Project Naming Conventions
The standard File Structure for InRoads is a Project Folder named for the PI Number of the
project. A sub-folder — named Photogrammetry — will be located under this PI Number.
This is the folder location where the core Photogrammetry File data is located. When
submitting project deliverables to the District Location Engineer and/or Survey Data
Engineer — submit the entire Project Folder (Example: the Pl Number Folder and the
associated Photogrammetry sub-folder). This will ensure that all of the applicable files are
submitted to the end-user. (See Table 2.1)

Table 2.1

Standard Project Naming Conventions

InRoads Project Structure | C:\InRoads Data\PI Number\ Photogrammetry

(Example)

InRoads Project Structure | C:\InRoads Data\123456\ Photogrammetry

2.1.2 Standard File Naming Conventions
InRoads contains several different file types but the Photogrammetry data will usually
consist of file types pertaining to the .DTM (Digital Terrain Model) and the associated
topographical .DGN (MicroStation Design File) file deliverables.
applicable file naming conventions (See Table 2.2)

Following are the

Table 2.2

Standard File Naming Conventions

File Type

File Name

3D “Working” DGN file

GDOT 3D Working File.dgn

Processed DTM Surface file

Pl#_Map.dtm

Processed Topographical DGN file

PlI# Map.dgn

Processed DGN PDF Plot Files

Pl#_Mapl.pdf, Pl#_Map2.pdf, etc
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2.2 Standard Surface Feature Object Names

The .RAW AMSA (Automated Mapping System-Advanced) files are imported directly into
InRoads through an internal Import AMSA Translator. The InRoads AMSA translator then
parses the RAW file coordinate and point data directly into a DTM surface. (The RAW AMSA
importation/translation process is discussed in more detail in the Introduction to InRoads for
Photogrammetry Training Guide).

The end result is that the AMSA data is imported in as surface features into a surface. Each
Feature object is assigned a unique naming scheme based on the Feature Style — Example:
TPBL1, TPBL2, TPBL3, etc. The internal surface points are numbered consecutively in the
particular Feature Object - Example: 1, 2, 3, etc. Each Feature can be made up of one or many
points. The Feature Style is based on the associated numeric Feature Code and is assigned
during the AMSA Import Translation process. The Feature Style determines if the Feature will
be included in the triangulation process.

The Feature Type affects how the DTM triangles are formed. The Feature Type can be a
breakline, random point, etc. and is determined based on a setting in the corresponding Feature
Style. The attribute of the Surface Feature (whether it is 3D topographic or a 2D planimetric
Feature) and the triangulation effect is also determined during the translation process.

The Standard Object Names for the Surface Features are determined by the Feature
Code/Feature Style — this is an automated process so that the Standard Object Names are
already defined for the user.

Following are some examples of the translated Features located in the DTM surface:
(See Table 2.3)

Table 2.3
Example Standard Object Names
Feature Style Feature Name
TOPO_E_TPBL TPBL991
TOPT_E_TPBL TPBL992
TOPO _E_TRCRE TRCRE10
TOPO E_ TWFB TWFB12

The Mapping Exterior Boundary will be named as MBOUNDARY. (See Table 2.4)

Table 2.4
Example Exterior Boundary Naming Conventions

Exterior Boundary Type Feature Name Feature Style
Mapping Exterior Boundary MBOUNDARY TOPO_E TLIML
Full Field Survey Boundary XBOUNDARY TOPO_E_TLIML
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2.3 Standard Surface Feature Types

InRoads contains five Feature Types: Breakline, Random, Contour, Interior and Exterior.
These Feature Point Types are set according to the corresponding Feature Code/Feature Style
in the standard GDOT Preferences file (GDOT _Standard V8i.xin). As mentioned previously,
the Feature Point Type determines how DTM triangles are formed when the points are
connected. When the data in the RAW file is imported during the AMSA translation process —
the correct Feature Type is automatically assigned by the Feature Style and to the Feature
Object which is imported into the Surface. Following are examples of the Feature Types: (See
Table 2.5)

Table 2.5
Example Surface Feature Types

Feature Type Description

Breakline Linear  connected points that represent
discontinuities in a surface

Random Randomly spaced points that are independent of
other points

Contour Connected points that form a linear segment based
on elevation

Interior Interior connected points that represent areas in a

DTM that are undefined or obscured

Exterior Exterior connected points that represent the outer
limits of a DTM surface and can be used to trim
extraneous triangulated data
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2.4 Standard Preferences

InRoads Standards for the Photogrammetric process have been set up in a “Preference” file
(also known as an XIN file). This preference file contains the Georgia Department of
Transportation’s standards for Feature Codes, Feature Styles, Feature Filters, Dialog Box
Settings, Linestyles, Lineweights, colors, and numerous other settings. The XIN file is
basically a compilation of INI Files (Initialization files) which controls the standardization of
the InRoads settings and display options. This preference file is critical for use in the InRoads
Photogrammetric Process and for accurate Digital Terrain Model creation. The XIN file is used
in conjunction with MicroStation V8i’s ByLevel settings and configuration files to assist in the
viewing of project data and in the generation of topographical DGN plan file deliverables.

The standard GDOT XIN file is named GDOT _Standard V8i.xin and is included in the
InRoadsALLV8i.exe download.

After downloading and executing the InRoadsALLV8i.exe — a Standards folder is created
directly under the C:\InRoads Data folder. The Photogrammetrist will copy this Standards
folder to the Project Folder: (See Example in Table 2.6).

Table 2.6

Name and Location of the GDOT Standard XIN File

GDOT Standard XIN File | C:\InRoadsData\123456\Photogrammetry\Standards\GDOT _
Standard V8i.xin

NOTE: The XIN file contains Named Symbology and Feature Styles which correspond
with the ByLevel Settings in MicroStation. Please note that if any modifications or
additional Feature Styless/Named Symbology are added by the user to the XIN - the
MicroStation Levels may not view with the correct Symbology for those modified Feature
Styles. It is advisable to NOT add additional Named Symbology or Styles in order for the
XIN file to be consistent with the current MicroStation Bylevel settings so that utilities for
Plans Productions will function correctly.

NOTE: For all Mapping Project DTM’s — the Photogrammetrist should use the Preference
named EXISTING when viewing the DTM Triangles:

EXISTING View Triangles Surface P View Surface » For use when viewing the
Triangles » Preferences Existing DTM.
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2.4.1 Standard Preference File (XIN) Details
The XIN File contains the GDOT configuration settings for use in
Photogrammetry/Survey/Design. These settings contain the current GDOT standards for
plan development and processing of Photogrammetry/Survey/Design Data. Following are
some of the Configuration Settings contained in the XIN:

e Named Symbology — This controls how elements such as points, lines, text, etc.
appear in plan, cross section and profile views in MicroStation. The GDOT named
symbology is also set to ByLevel which references the Level Settings for
Symbology in the MicroStation DGNLIB. BylLevel controls the Symbology
(weight, color, linestyle) and the Named Level on which the elements are located.
The Named Symbology can also be set in the InRoads Named Symbology Manager
by selecting each symbology (color, weight, linestyle, etc.) separately but GDOT
uses the ByLevel Symbology to correspond with the DGNLIB Levels. (The
Named Symbology determines “How” an element is viewed”).

e Feature Styles — InRoads contains Features which represent elements such as
points, lines, arcs, spirals, etc. The Feature Style for each Geometry, Survey, DTM
and Component element is used to determine how the elements view. The elements
can be set to view in plan view, profile, cross section, DTM, etc. The Feature Style
references the associated Named Symbology to view the element with the
appropriate corresponding Symbology. The Feature Style determines “Where” the
element is viewed.

e Preferences — When using commands in the InRoads dialog boxes — it is useful to
set Preferences which can be loaded later without having to re-enter information
into the dialog boxes. Preferences are basically entries in dialog boxes which can be
saved and then selected to automatically configure the settings of a dialog box
without manual re-entry.

e Filters — Filters are commands in dialog boxes which can be used to “filter”
selections of data based on set criteria. This can include selection of Points,
Alignments, Features or other entities by using a filter based on the entities” Style,
Name, etc.

These are some of the GDOT standards that have been configured for use in the XIN file.
These settings are used to assist in the Photogrammetry/Survey/Design process to ensure
that standards are consistent for development of GDOT project plans.
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2.5 GDOT Standard InRoads Photogrammetric Feature Codes

The following spreadsheet contains the standard Numeric AMSA Codes and the associated
InRoads Alpha Codes for use in Photogrammetry. The Triangulate (Yes/No) column is for
informational use only. This column denotes the status of the Alpha Code and lists whether it is
triangulated or not triangulated in the DTM Surface.

GDOT STANDARD PHOTOGRAMMETRY CODES

AMSA Description InRoads Triangulate
Code Alpha Code (Yes/No)

1 TERRAIN POINT ON BREAK LINE TPBL Y

2 RANDOM TERRAIN POINT TRP Y

27 EDGE OF ASPHALT PAVEMENT TEAP Y

28 EDGE OF ASPHALT SHOULDER TEAS Y

33 CURB & GUTTER, TOP TCGT Y

34 CURB & GUTTER, F/L TCGF Y

35 V-GUTTER TVG Y

57 DRAINAGE OBSCURE AREA DOBSC Y

96 WALL FACE, TOP TWFT Y

97 WALL FACE, BOTTOM TWFB Y

127 LIMIT LINE TLIML N

128 CONSTRUCTION BOUNDARY, ACTV TCBA Y

150 JOB LIMIT LINE MJLL N

151 DITCH FLOW LINE MDITCHFL | Y

155 TOP OF RAIL ROAD RAIL TRCRE Y

157 SEW LINE MSEWLINE | Y

159 OBSCURE AREA MOBSC Y
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2.6 GDOT Standard InRoads Field Survey Feature Codes
The following spreadsheet contains the standard Numeric SMI Codes and the associated
InRoads Alpha Codes for use in Field Survey. The Point Type and Chain Type
Triangulate (Yes/No) column(s) are for informational use only. This column denotes the
status of the Alpha Code and lists whether it is triangulated or not triangulated in the DTM
Surface and whether it is a Point Type or a Chain Type.

GDOT STANDARD FIELD SURVEY CODES

Csol\gle Description InAF\I)gﬁgs ITDrci)g:]tg-LrJ)I/gti 'cl':rr: :Lng Ilyt'clptg Gcrc())(;J:
Code (YIN) (YIN)
Ground Elevations
1 TERRAIN POINT ON BREAK LINE TPBL Y 4
2 RANDOM TERRAIN POINT TRP Y 2
Property and Right-of-Way
3 RIGHT-OF-WAY MARKER FOUND RWM N 1
4 RIGHT-OF-WAY POINT COMPUTED RWC N 1
5 RIGHT-OF-WAY UTILITY COMPANY RWU N 1
6 RIGHT-OF-WAY PRESCRIPTION PT RWE N 3
7 POINT ON EASEMENT LINE POEL N 1
8 PROPERTY CORNER FOUND PCF N 1
9 PROPERTY POINT ON LINE PPOL N 1
10 PROPERTY POINT COMPUTED PPC N 1
Alignment
15 POINT ON TANGENT, EXISTING APOT N 1
16 POINT OF CURVATURE, EXISTING APC N 1
17 POINT ON CURVE, EXISTING APOC N 1
18 POINT OF TANGENCY, EXISTING APT N 1
19 POINT OF INTERSECTION API N 1
20 ALIGNMENT CENTERLINE ACL N 3
Roadways
24 EDGE OF DIRT ROAD TEDR Y 4
25 EDGE OF ASPHALT DRIVE TEAD Y 4
26 EDGE OF CONCRETE DRIVE TECD Y 4
27 EDGE OF ASPHALT PAVEMENT TEAP Y 4
28 EDGE OF ASPHALT SHOULDER TEAS Y 4
29 EDGE OF CONCRETE PAVEMENT TECP Y 4
30 EDGE SURFACE TREATMENT ROAD TEST Y 4
31 CURB, ASPHALT TAC Y 4
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32
33
34
35
36
37
38
39
40
41
42
43
44

45
47
49
50
51
52
53
54
55
56
57
59
60
61
62
63

68
69
70
71
72
73
74

Roadways

CURB, HEADER

CURB & GUTTER, TOP
CURB & GUTTER, F/L
V-GUTTER

BRIDGE APPROACH SLAB, EDGE
BRIDGE END, CENTER
BRIDGE END, CORNER
BRIDGE COLUMN, CENTER
BRIDGE COLUMN, EDGE
BRIDGE GUTTER LINE
BRIDGE CENTERLINE
ENDROLL

BRIDGE CAP

Drainage

SINGLE CATCH BASIN, Gutr F/L
DOUBLE CATCH BASIN, Gutr F/L
DROP INLET, TOP

SPUR DIKE

TOP OF WATER ELEVATION
STREAM CENTER, F/L

STREAM EDGE

STREAM BANK TOP

DAM, TOP

DAM, TOE

OBSCURED AREA

HEAD WALL, END

CULVERT, WINGWALL END
EDGE OF WATER

SWAMP EDGE

WETLAND BOUNDARY

Utilities

STRAIN POLE

ELECTRICAL BOX

OVERHEAD ELECTRICAL LINE
OVERHEAD TELEPHONE LINE
POWER POLE, CENTER

LIGHT POLE, CENTER
TELEPHONE POLE, CENTER

THC

TCGT

TCGF

TVG

TBAS
TBRDGCEN
TBRDGCOR
TCOLC N
TCOLE N
TBGL

TBCL
TENDROLL Y
TBCAP N

ZzZz<<<<<

zZz Z

DCB N
DDCB N
DDI N
DSPURDK

DWE N
DSC

DSE

DSB

DDT

DADB

DOBSC

DHWE

DCWE

DEW

DSWE

DwB

<

ZzZzzZzzZz2zZ2<<<<<<

USTRPOL N
UELBOX

UOEL N
UOTL N
UPP N

ULP N

UTP N

pzd
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75
76
77
78
79
80
81
82
83
84
85
86
87
88
89
90
91
92
93

95

96

97

98

99

100
101
102
103
104
105
106
107
108
109
110
111
112
113
115

Utilities

TELEPHONE PEDESTAL, CENTER
GUY POLE, CENTER

POLE ANCHOR

YARD LIGHT, ELECTRICAL
YARD LIGHT, GAS

WATER METER, CENTER
WATER VALVE

FIRE HYDRANT, CENTER
MANHOLE STORM SEWER, TOP
MANHOLE STORM SEWER, F/L
MANHOLE, TELEPHONE, TOP
MANHOLE, ELECTRICAL, TOP
MANHOLE, SANITARY SEWER, TOP
MANHOLE, SANITARY SEWER, F/L
SANITARY SEWER LINE, CENTER
GAS METER, CENTER

GAS VALVE, CENTER

GAS VENT PIPE

GAS LINE MARKER

General Topo

WALL FACE

WALL FACE, TOP

WALL FACE, BOTTOM
IRRIGATION PIVOT POINT
IRRIGATION LIMITS

SIGN, CENTER

GASOLINE MONITORING WELL
GASOLINE FILLER VALVE
GASOLINE VENT PIPE
GASOLINE PUMP

GASOLINE STORAGE TANK, END
GASOLINE PUMP ISLAND
CANPOY

BUILDING CORNER

BUILDING ROOF LINE CORNER
HOUSE CORNER

HOUSE ROOF LINE CORNER
MOBILE HOME CORNER
MOBILE HOME ROOF LINE CORNER
WOODS LINE

UTPD
UGP
UPGA
UYLE
UYLG
UwWM
uwv
UFH
UMHST
UMHSTF
UMHT
UMHE
UMHSS
UMHSSF
USSL
UGM
UNGV
UNGVP
UNGLM

TWF
TWFT
TWFB
TIRRPVTP
TIRRLMT
TSC
TGMW
TGFV
TGVP
TGP
TGST
TGPI
TCAN
TBLD
TBLDRL
THCR
THRL
TMHCR
TMHRL
TWL

Z2Z2Z2Z2222Z2Z2ZZ2Z2Z2Z22Z22Z22Z22Z2Z2Z2

Z2Z2Z2Z2Z22Z2 2

<<z

2 Z2Z2Z2Z2Z2222Z22Z2
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116
117
118
119
120
121
122
123
124
125
126
127
128
129

130
131
132
133
134

**152
**153
**154
**156
**158
160

161

**162
**163
**164
**165
**166
**167
**168
**169
**170

General Topo
CULTIVATION LINE
FENCE, FIELD WIRE
FENCE, BARB WIRE
FENCE, WOOD
RAILROAD, TOP OF RAIL
RAILROAD, CENTERLINE
CEMETERY LINE

GRAVE

GUARDRAIL

SIGN, END

SATELLITE DISH

LIMIT LINE
CONSTRUCTION BOUNDARY, ACTV
CONSTRUCTION BOUNDARY, FIND
Boundaries

COUNTY LINE

CITY LIMIT LINE

LAND DISTRICT LINE
LAND LOT LINE

STATE LINE

New Codes

HIGH WATER MARK
FLOOR ELEVATION
EDGE OF DIRT DRIVE
GATE

UNCOVERED DECK
MAP CHECK GROUND
MAP CHECK PAVEMENT
VINYL (PVC) FENCE
FUEL TANK

PAVE DITCH

BRICK COLUMN

SEPTIC TANK CENTER
STEPS

HISTORICAL MONUMENT
FLAG POLE

DRAIN LINES

TCUL
TFFW
TFBW
TFW
TRCR
TRCL
TCEM
TGRV
TGR
TSE
TSATDSH
TLIML
TCBA
TCBF

BCOL
BCTL
BLDL
BLLL
BSL

DHWM
TFE
TEDD

TG

TUD
MPCKGRD
MPCKPAV
TVF

TFT

DPD

TBC
DSTC

TS

THM

TFP

DDL

Z2Z2<< Z2zZ2zZ2zZ22 < < < Z2Z2Z2Z2Z222222

2<zZ2Zz2

zZz Z
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171
172
173
174
175
176
177
178
179
180
181
182
183
184
185
186
187
188
189
190
191
192
193
194
195
196
197
198
199

200
201
202
**203

210
211
212
213

Surveyor Defined

Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value
Surveyor Defined Value

Dimension Codes: (Drainage)
DRAINAGE PIPE, F/L, C
DRAINAGE PIPE, F/L, M
DRAINAGE PIPE, F/L, P

CULVERT END, F/L

Dimension Codes (General Topo)

SIDEWALK, CENTER
FENCE, CHAIN LINK
TREE, CENTER
WELL

XXA
XXB
XXC
XXD
XXE
XXF
XXG
XXH
XXI
XXJ
XXK
XXL
XXM
XXN
XXO
XXP
XXQ
XXR
XXS
XXT
XXU
XXV
XXW
XXX
XXY
XXZ
XXZA
XXZB
XXZC

22222222 <<X<<KXK<KXK<K<<<L

DPC
DPM
DPP
DCEF

TSW
TFCL
TTRE
TWELL N

Z

2222222 <<<K<K<KXK<K<<LK<L

Z2Z2Z2 2
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225
227
235
236
237

240
241
242
243
244
245
250

Dimension Codes (Roadway)
DIRT ROAD, C/L

DIRT DRIVE, C/L

MILE POST, RAILROAD

KM POST, HIGHWAY

MILE POST, HIGHWAY

Survey control

NGS CONTROL MONUMENT
LOCATION CONTROL MONUMENT
LOCATION CONTROL DELTA
DISTRICT CONTROL DELTA
CONTROL RE-SHOT FOR CHECK
BENCHMARK

MISCELLANEOUS

TDR
TDD

TMPR
TKMP
TMPH

SNGSCM
SLCM
SLCD
SDCD
SCCHK
SBNCHMK
MISC

zZ Z

2 zZ2zZzZ2Z22Z 2

zZz Z

*SMI # = For InRoads Use Only! Do NOT use in CAICE.

SMI Codes For InRoads

User Defined Codes

171-177
178-184
185-191
192-199

Group Code 4
Group Code 3
Group Code 2
Group Code 1

Group Codes

Code 1
Code 2
Code 3
Code 4

2-D Point
3-D Point
2-D Chain
3-D Chain

2-14
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2.7 GDOT Photogrammetry Code Conversion Table -- CAICE to InRoads

Several AMSA Feature Codes have been consolidated and/or updated to correspond to the
InRoads Software Standards. The following spreadsheet contains the Photogrammetry Code
Conversion Table which depicts the “old” CAICE AMSA Code along with the “new”

associated InRoads AMSA Code. This table is for reference only ---

Old AMSA

Old CAICE

Feature Feature Converted >>> F’:sett\ﬁ ré'\é?)ﬁe InRog((j)ZéAlpha
Code Code
150 BORDER = 150 MJLL
151 DITCH = 151 MDITCHFL
152 EPSHLD = 27 TEAP
153 EP = 28 TEAS
154 TOC = 33 TCGT
155 BOC = 34 TCGF
156 CL = 1 TPBL
157 CLIP = 157 MSEWLINE
158 RANDOM = 2 TRP
159 OBSC = 159 MOBSC
160 LAKE = 159 MOBSC
161 RRCL = 155 TRCRE
162 RIVERED = 159 MOBSC
163 TOWALL = 96 TWFT
164 BOWALL = 97 TWFB
165 BREAKLIN = 1 TPBL
166 CONSTRB = 128 TCBA
5 PAVEROAD = 27 TEAP
6 PAVESHLD = 28 TEAS
8 CURBROAD = 33 TCGT
35 CURBPARK = 33 TCGT
43 DITCH = 151 MDITCHFL
63 PVDDRAIN = 35 TVG
241 TOC = 33 TCGT
242 BOC = 34 TCGF
243 BREAKLIN = 1 TPBL
244 DEADIN = 57 DOBSC
245 RANDOM = 2 TRP
246 BORDER = 127 TLIML

Y
'—\
o
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3. Photogrammetry Project Deliverables

This section provides an overview of the Photogrammetry Project Deliverables which will be
submitted to the District Location Engineer/District Survey Data Engineer.

This section covers the following topics:

® Processing of the Mapping Surface
® Generation of the Topographical DGN File
® Listing of the Photogrammetry Project Deliverables

MicroStation [ InRoads
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3.1 Processing of the DTM Surface

For detailed instructions regarding the generation and processing of the Photogrammetry Data
and the creation of the DTM Surface — please refer to the “Introduction to InRoads for
Photogrammetry” Training Tutorial. Detailed information for the processing of the
Photogrammetry Data is listed and described in Labs 1-7.

Following are some Quality Assurance Verification Items to review in order to insure that an
accurate DTM Model is created:

Photogrammetry Data:

e Make sure that all crossing segments and crossing overlaps are resolved
Ensure that there is only one Exterior Boundary

Verify that the Exterior Boundary Feature Name is MBOUNDARY

Ensure that the Exterior Boundary is a closed shape entity

Verify that all Interior Boundaries are closed shape entities

Check to ensure there are no erroneous (bad) point elevations

Verify that Standard GDOT Naming Conventions and Feature Styles are used

DTM Surface Data:

Make sure that the DTM is created using the “EXISTING” Preference
Ensure that the Maximum Triangle Length of 300.00 is used.

Verify that the DTM contains no erroneous “Spikes”

Verify that all extraneous triangles are trimmed

Ensure that all MOBSC Features (obscured areas) are obscured

Make sure to compress the DTM Surface before submittal to the SDE

3-3
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After the DTM Surface data has been verified and all errors corrected - the next step is the
completion of the final processing of the DTM Surface. The DTM Surface will be re-
triangulated and compressed (which will release memory slots that contain deleted data).

1. Save the InRoads Surface File

After re-triangulating and compressing the DTM Surface — the data will need to be

saved. As mentioned previously, InRoads retains the data in temporary memory but
does not save the data on the fly. Whenever a change has been made to an
InRoadsSurface Project — Save the project and its associated modifications or changes.

Select File»Save» Surface from the InRoads Menu and save to the following
location:

C:\InRoads Data\123456\Photogrammetry

Please Note: (The “Save As” dialog box may not appear because the Surface has
already been saved initially).

2. The PI#_Map.dtm Surface Project is now ready for submittal to the District. This file
will be sent to the District SDE as a completed Surface Project. This .DTM file
replaces the CAICE .SRV file format. The DTM file contains all of the Features
(random points, breaklines, border, obscured features, etc.) that used to be contained in
the CAICE .SRV File. The DTM Surface is already triangulated for the SDE so that he
can begin adding the field enhancements.
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3.2 Generation of the Topographical DGN File
After the final processing of the DTM Surface, a topographical DGN file will be
generated for submission to the Districts. This file will include all of the 2D
topographical data obtained from the photogrammetric survey.

The initial TOPO file will be generated from AMSA in a MicroStation J (\V7) format. A
translation table has been created which can be used to convert the V7 file to a V8i
format. All of the “old” Number Levels will automatically be converted to the new
associated V8i “Named Levels”. The process for generating this data is detailed in a
separate MicroStation “Translation Process” Guideline.

1. Save the DGN File with a New Name:
After using the translation table to create the MicroStation Topographical V8i file -- the
DGN file will need to be saved with a standard naming convention in order to submit to
the District.

Table 3.1
Standard Topographical DGN File Name

Topographical DGN Path/File Name C:\InRoads Data\PI Number\ Photogrammetry\
P1#_Map.dgn

Topographical DGN Path/File Name | C:\InRoads Data\123456\ Photogrammetry

(Example) 123456_Map.dgn

In the [MicroStation Software] —
“Fit the Active View” so that all the data appears in the MicroStation View Window.
2. Select File»Save As» from the [MicroStation Menul].

Save the DGN File as (123456 _Map.dgn) to the path shown below -- under the folder
Photogrammetry --

C:\InRoads Data\123456\Photogrammetry

3. Inthe [MicroStation Software] —

Select File » Compress » Design from the [MicroStation Menu].
(This will compress and reduce the size of the MicroStation file).

The 123456 _Map.dgn File is now ready for submittal to the District.
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3.3 Listing of the Photogrammetry Project Deliverables
After the DTM Surface has been processed (123456 Map.dtm) and the DGN file
(123456_Map.dgn) has been created - the Office of Design Policy and Support/Location
Bureau will submit the following information to the Districts either by delivery of a CD
or submittal on a Network Share:

The Final Deliverables include the following:

A processed DTM Surface file (P1#_Map.dtm)

A topographical DGN file (PI#_Map.dgn)

DGN Plot Files (.pdf)

Mapping Photographs

A Roll Plot of the topographical DGN data (if required)

A Photogrammetry Quality Assurance Checklist Document

PLEASE NOTE:

A Photogrammetry Quality Assurance Checklist will be documented by the GDOT
Office of Design Policy and Support/Location Bureau and/or the Consultant Firm
performing the Photogrammetry Processing work. This document lists several areas
including the Photogrammetry Data, DTM Surface and Final Deliverables which need to
be verified before Project Submittal. This Document is a required Deliverable and will be
submitted with the previously listed Deliverables.

The following page contains the example Photogrammetry QA form which will be
completed and submitted. The Photogrammetry Quality Assurance Checklist is
available for download by navigating to the MicroStation and InRoads links from the
following location:

http://www.dot.ga.gov/doingbusiness/PoliciesManuals/roads/software/Pages/default.aspx
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Georgia Department of Transportation

P.l. Number:

T&!l—-x—-‘:lr County:

Keaping Georgia on the Mowve

Project Description:
QA Reviewer:

Phone Number:

GDOT Photogrammetry Quality Assurance Checklist

(Instructions: In the Verified Column — enter YES, NO or N/A for the Verification QA Status)

CATEGORY TASK

Photogrammetry Data All crossing segments and crossing overlaps are resolved
There is only one Exterior Boundary
The Exterior Boundary Feature Name is MBOUNDARY
The Exterior Boundary is a closed shape entity
All Interior Boundaries are closed shape entities
There are no erroneous (bad) point elevations

Standard GDOT Naming Conventions and Feature Styles used

DTM Surface The DTM is created using the “EXISTING” Preference
A Maximum Triangle Length of 300.00 is used
The DTM contains no erroneous ‘Spikes’
All extraneous triangles are trimmed
All MOBSC Features (obscured areas) are obscured

Compress the DTM Surface before Submittal to SDE

Final Deliverables A processed DTM Surface File named (PIl#_Map.dtm)
A topographical DGN File named (PI#_Map.dgn)
DGN Plot Files (.PDF)
Mapping Photographs
Roll Plot of the Topo DGN (if required)

Photogrammetry Quality Assurance Checklist

VERIFIED

3-7
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4. Converting Projects from CAICE to InRoads

This section provides a brief summary of the procedure to convert CAICE Photogrammetry
Projects to InRoads Photogrammetry Projects. A stand alone program has also been coded which
will translate “old” CAICE Codes to the new “InRoads” Codes.

This section covers the following topics:

® CAICE to InRoads Conversion Criteria Overview
® Overview of CAICE to InRoads Project Conversion
® Review of the AMSA XLS Numerical Code Converter
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4.1 CAICE to InRoads Conversion Criteria Overview
The following section depicts an overview of the criteria of determining whether a CAICE
Project is a good candidate for conversion to an InRoads Project. There are several deciding
factors which must be considered and discussed before converting a CAICE Project.

It is critical that all parties involved in the decision to convert a CAICE Project to an
InRoads Project be aware of all the data, conversion processes and conversion time required.
Following is an excerpt from a Design Policy Interdepartmental Correspondence which is
dated April 13, 2010.

“The CAICE platform will continue to be maintained by the Department’s Engineering
Software Group to support projects already under development with CAICE. Projects
with a database collected in CAICE prior to May 1, 2010, may be converted to InRoads.
A decision to convert from CAICE to InRoads should be made mutually between the
Project Manager, Design Phase Leader, and the Statewide Location Bureau Chief.”

The following section depicts some criteria to keep in mind when discussing possible
CAICE to InRoads Conversions:

o0 There is currently no automated direct process to convert a CAICE Survey Project to
an InRoads Survey Project. The only method at this time is to convert the RAW
Photogrammetry Data and RAW Field Survey Data (using customized GDOT
Conversion Programs) to an InRoads format. After processing this data — the Survey
Data Engineer must manually re-create the Property/Parcel Alignments in InRoads
which can be a very time-consuming process.

0 There is also no automated direct process to convert CAICE Design Data to an
InRoads format. The Designer must manually re-input all the Horizontal
Alignments, Vertical Alignments, Templates, Cross-Sections, and Required R/W
Alignments from Reports and Plans generated from CAICE.

0 There is also an InRoads Software learning curve for Surveyors, Survey Data
Engineers and Designers. This in turn will extend the projected project schedule for
completion.

0 Manpower and productivity is also a consideration. Converting a CAICE Project to
InRoads will result in Survey Data Engineers and Designers having to basically start
at the beginning of a Project. Although the Photogrammetry/Survey RAW data can
be converted with minimal effort (and no additional Field Survey Work) — the time
allotted for Survey Data Engineers and Designers to recreate the InRoads work can
affect much of the Project Schedule.

0 As mentioned in the Design Policy Excerpt in the paragraph above — Project
Conversion is a mutual decision that must be determined and approved by all parties
involved on a case by case basis.

43
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4.2 Overview of CAICE to InRoads Project Conversion
The following section depicts an overview of the methods used to convert a CAICE
Photogrammetry Project to an InRoads Photogrammetry Project.

Please Note:

ALL conversions of Photogrammetry data from CAICE to InRoads will be performed by the
Office of Design Policy and Support/Location Bureau. If the Project Manager, Design Phase
Leader, and the Statewide Location Bureau Chief determine a need for project conversion — the
Project Manager should contact the Engineering Management/Operations Manager of the
Office of Design Policy and Support for details.

It has been determined that the best method for converting CAICE to InRoads projects is to
utilize the “base” RAW AMSA Files (which contain the old CAICE Feature Codes) for the
conversion. Please note that any processing done in CAICE will be lost when going back to the
RAW file. There are several reasons for utilizing the RAW AMSA Files instead of a direct
CAICE to InRoads Conversion:

Issues with direct CAICE to InRoads Conversion:

e There are significant differences between CAICE and InRoads as it pertains to the creation of
Digital Terrain Models. Although the standard TIN (Triangulated Irregular Network) method is
utilized — the format and naming conventions of the points and breaklines are considerably
different from CAICE. Therefore a direct DTM import from CAICE to InRoads is not feasible.

e There has been a considerable change in the AMSA Feature codes for InRoads. The AMSA
codes have been updated and consolidated to correspond more closely with the associated SMI
Codes. CAICE projects will contain the “old” CAICE AMSA codes. Therefore the importation
of CAICE projects into InRoads is not feasible because of the discrepancy in Feature Codes.
The CAICE codes will not import into InRoads correctly.

The conversion of the (CAICE format) RAW AMSA files will ensure an accurate translation of
“old” CAICE Photogrammetry data to “new” InRoads Photogrammetry data. This will entail
rebuilding the DTM and resolving any crossing segments, etc. but it will also result in an accurate
conversion method.

There is a stand-alone program which has been coded for use in CAICE Photogrammetry data
conversions.

® AMSA XLS Numerical Code Converter

This program will translate and convert the “old” format CAICE Feature Codes to the “new”
format InRoads Feature Codes/Feature Styles. The following sections(s) details the conversion
program which are available to convert the CAICE Photogrammetry Data to InRoads
compatible data.
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4.3 Review of the AMSA XLS Numerical Code Converter

This stand-alone program converts the “old” CAICE RAW AMSA Feature Codes to the “new”
InRoads RAW AMSA Feature Codes. These converted files can then be imported directly into
InRoads as RAW AMSA files. The AMSA XLS Numerical Code Converter is included in
the InRoadsALL.exe download. (See Section 1.1 for InRoadsALLV8i.exe download
information).

The Translation table which is used in the conversion is depicted in Section 2.7 (GDOT
Photogrammetry Code Conversion table — CAICE to InRoads).

Following are the steps to utilize the AMSA XLS Numerical Code Converter:

AMSA XLS File Numerical Code Lpdation

Select the RAW File

Browse

| Process | LCancel |

Ready

Figure 4-1 AMSA XLS Numerical Code Converter

1. Open the AMSA XLS Numerical Code Converter program by double clicking the
InRoads AMSA Converter (Desktop Shortcut).

2. Browse to the “old” AMSA file which is to be converted.
3. Select the appropriate AMSA file and then click Process.

4. A message will appear in the bottom left-hand corner of the program which informs the
user that the data is being processed.

5. It may take a while for the file to process depending on the size of the file.

6. In Order to access the InRoads AMSA Converter “Help File” — browse to the folder
C:\Program Files\InRoads_ AMSA_Converter\Help

7. After processing is complete — a message box will appear listing the location of the
created file. (The word “_NewCodes” will be appended to the original name of the file.
(See example screen capture below):

The RAW file C:1InRoads Datallz34561\Phoktogrammetry LabsiLab 214M34 Files) 20564 MewCodes RAMW has been successfully created!
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APPENDIX A REFERENCE GUIDE TO PHOTOGRAMMETRY TABLES

Table A-1

InRoads Project Structure

InRoads Project Structure C:\InRoads Data\PI Number\ Photogrammetry

InRoads Project Structure C:\InRoads Data\123456\ Photogrammetry

(Example)
Table A-2
Standard Naming Convention of the “Working” DGN File
Working DGN File Name C:\InRoads Data\PI Number\

Photogrammetry\Standards

GDOT 3D Working File.dgn

Table A-3

Project Default Configuration

Project Default Structure | PI Number_Mapping

Project Default Structure | 123456_Mapping
(Example)




Table A-4

InRoads Locks Settings

Feature Filter Unchecked
Feature Highlight Unchecked
Style Unchecked
Pencil/Pen %, Set to Pencil
Delete Ink Unchecked
Locate =¥ Set to Features
Point Snap |+ Checked
Element Snap Unchecked
Station Unchecked
Cogo Audit Trail Unchecked
Report |+~ Checked
Toolbar |+ Checked




Table A-5
InRoads Locks Overview

Feature Filter
displays or obscures Surface Features based on a filter (also controls Survey Style Filter)

Feature Highlight
highlights the feature in plan view when selected from a list

Style
determines if a dialog box is displayed for a surface command or cross sections

Pencil/Pen
controls the redisplaying of Graphics

Delete Ink
allows redisplayed graphics to replace graphics in pen mode

Locate
controls if Locate Buttons snaps to Graphics or Features

Point Snap
controls the ability to snap to points in Geometry Project

Element Snap
controls the ability to snap to elements in Geometry Project

Station
controls the Stationing as it pertains to Cross Sections

Cogo Audit Trail
controls the reporting of coordinate geometry results to a text file

Report
controls if Report is displayed or not displayed in a dialog box

Toolbar
displays or turns off the Locks Toolbar




Table A-6

Standard Project Naming Conventions

InRoads Project Structure | C:\InRoads Data\PI Number\ Photogrammetry

InRoads Project Structure | C:\InRoads Data\123456\ Photogrammetry
(Example)

Table A-7

Standard File Naming Conventions

File Type File Name

3D “Working” DGN file GDOT 3D Working File.dgn

Processed DTM Surface file Pl#_Map.dtm

Processed Topographical DGN file | PI#_Map.dgn

Processed DGN PDF Plot Files Pl#_Mapl.pdf, PI1#_Map2.pdf, etc
Table A-8

Example Standard Object Names

Feature Style Feature Name
TPBL TPBL991
TPBL TPBL992
TRCRE TRCRE10
TWFB TWFB12




Example Exterior Boundary Naming Conventions

Table A-9

Exterior Boundary Type Feature Name Feature Style
Mapping Exterior Boundary MBOUNDARY TOPO_E_TLIML
Full Field Survey Boundary XBOUNDARY TOPO_E TLIML

Table A-10

Example Feature Types

Feature Type

Description

Breakline Linear  connected points that  represent
discontinuities in a surface

Random Randomly spaced points that are independent of
other points

Contour Connected points that form a linear segment based
on elevation

Interior Interior connected points that represent areas in a
DTM that are undefined or obscured

Exterior Exterior connected points that represent the outer

limits of a DTM surface and can be used to trim
extraneous triangulated data

Table A-11

Standard Name and Location of the GDOT Standard XIN File

GDOT Standard XIN File

C:\InRoadsData\123456\Photogrammetry\Standards\GDOT _
Standard V8i.xin




Table A-12

Standard Exterior Boundary Name and Feature Style

Exterior Boundary Seed Name Exterior Boundary Feature Style

MBOUNDARY TOPO_E_TLIML

Table A-13

Standard Topographical DGN File Name

Topographical DGN Path/File Name | C:\InRoads Data\PI Number\ Photogrammetry\
Pl# Map.dgn

Topographical DGN Path/File Name | C:\InRoads Data\123456\ Photogrammetry

(Example) 123456_Map.dgn




